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Proyecto Erasmus+: BIMVET3 2020-1-ES01-KA203-083262
Este proyecto Erasmus+ ha sido financiado con el apoyo de la Comision Europea. Esta publicacion refleja Ginicamente las opiniones de los
autores, y la Comision Europea y las agencias nacionales Erasmus+ no se hacen responsables del uso que pueda hacerse de la informacion
contenida en ella.

Titulo: MODELO BIM CON REVIT MEP
1 - Objetivos
Capacidad para desarrollar un modelo BIM MEP, especificamente en el sistema de distribucién de agua.

Posibilidad de crear vistas isométricas y hojas utilizando el software Revit.

Capacidde para transmitir informacidon mediante BIM.
2 - Metodologia de aprendizaje

El profesor dard una explicacion sobre el uso de la herramienta.

Los estudiantes leerdn este tutorial y veran los videos, ejecutardn el ejercicio y exploraran las
herramientas y el entorno de MEP.

Para evaluar el desempeiio de la practica, cada estudiante necesita crear el sistema de Agua Fria
Doméstica y los dibujos de las hojas.

3 - Duraciodn del tutorial

La practica descrita en este tutorial se llevara a cabo en un aula de informatica.
Tendra una duracion de 6 horas de ensefianza.

4 - Recursos necesarios

Sala de ordenadores con ordenadores con acceso a internet.
Software requerido: Revit.

Hardware requerido: Computadora capaz de soportar software.

5- Contenido y tutorial
5.1 Introduccién
5.2 Interfaz de Revit MEP
5.3 Iniciar un proyecto

5.4 Modelo de arquitectura de enlaces
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5.5 Niveles adicionares
5.6 Sistemas de distribucion de agua
5.6.1 Equipo sanitario
5.6.2 Creacion de un sistema domético de agua fria
5.6.3 Notas
5.6.4 Crear tablas
5.6.5 Crear vistas isométricas
5.6.6 Creacion de hojas
6- Entregables
Un informe de 3 pdginas que muestre la ejecucion de este ejercicio.

7- Lo que aprendimos

Cdédmo vincular un modelo de arquitectura en el proyecto MEP.

Cémo colocar tuberias

Cdémo crear un sistema de Agua Fria Sanitaria, con tuberias y conexiones.

8 - Archivos para usar en este tutorial

El archivo de proyecto creado en el tutorial de Revit Architecture en formato .rvt.

5.1 Introduccion

Revit MEP es una parte o funcionalidad del software Autodesk Revit, dirigido a profesionales que trabajan
con proyectos de disefio mecanico, eléctrico (eléctrico) y de fontaneria, ya sea solo o como parte de un
proyecto BIM. Se trata de un conjunto de herramientas de Revit que permiten el desarrollo de modelos
BIM, utilizados para agilizar el proceso de disefio de ingenieria, haciendo mas eficiente el disefio y
desarrollo de productos.
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Este tutorial no pretende ensefiarle cdmo escalar sistemas en edificios, sino cdmo usar las herramientas
principales de revit para modelar sistemas. Es un ejercicio de funcionamiento del sistema, que no tiene
en cuenta las reglas para instalar sistemas que varian segun el pais.

En este tutorial, se utilizaran las familias basicas de la biblioteca de Revit. Sin embargo, actualmente varias
marcas que fabrican componentes de sistemas ponen a disposicidon en sus webs para su descarga sus
familias configuradas segun las dimensiones, materiales y otros pardmetros que se encuentran en el
mercado, para que el proyecto se acerque lo mas posible a la realidad.

5.2 Interfaz do Revit MEP

Es importante entender que Revit MEP no es un software independiente de Revit, sino mas bien una
parte de él, es decir, Revit MEP se inserta en el propio Revit.

Al igual que en el tutorial de Revit Architecture, la familiarizacidén con el escritorio y las herramientas de
navegacion y edicién ya ha sido posible, en el siguiente video se mostraran algunas herramientas para
usar proyectos MEP especificos.

https://www.youtube.com/watch?v=m3V97Pxsdt4

5.3 Iniciar un proyecto

Después de abrir el programa, en la pagina de inicio de Revit debe hacer clic en Nuevo y se abrird la
ventana Nuevo proyecto para seleccionar la plantilla de proyecto en la que desea trabajar. En este caso,
se utilizard una plantilla de Revit predefinida, Metric-Systems.


https://www.youtube.com/watch?v=m3V97Pxsdt4
https://www.youtube.com/watch?v=m3V97Pxsdt4
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MODELS
MODELS
& Open..
™ New. ‘
New Project X
FAMILIES
Template file

& Open.. <None> v | Browse...

<None>

Imperial-Construction Template
= New.. c[Imperial-Architectural Template

Imperial-Structural Template

{1mperial-Systems Template late

Metric-Construction Template

Metric-Architectural Template

Metric-Structural Template Help

@ RecentFiles P usil
B BIM360 Fur T

Sample Architecture Proj... Sample Structure Project

Si la plantilla Metric-Systems no aparece en las opciones de la ventana Nuevo proyecto, debe hacer clic
en Examinar para cargar esta plantilla. Se abrira la ventana Elegir plantillay, en la carpeta en inglés (Datos
del programa/Autodesk/RVT 2021/Templates/English), seleccione el archivo "Systems-Default_Metric"y,
a continuacion, haga clic en Abrir para cargarlo.

R Choose Template ? X
Look in: | English V| = .} X -+ Uz <
~ | Nome - Data de modificacéio & Freview .
DefaultMetric 17/01/2020 15:40 !
DefaultUS-Canada 17/01/2020 15:40 !
Electrical-Default_Metric 17/01/2020 15:39 ] . .
Electrical-DefaultGBRENU 19/01/2020 15:40 !
T_USM_Default 17/01/2020 15:42 !
Mechanical-Default_Metric 17/01/2020 15:40 } .
Mechanical-DefaultGBRENU 19/01/2020 15:40 J
My Computer Plumbing-Default_Metric 17/01/2020 15:42 ]
% Plumbing-DefaultGBRENU 19/01/2020 15:40 !
Precast Detailing-DefaultMetric 17/01/2020 15:42 }
% ResidentialGBRENU 19/01/2020 15:39 !
Structural Analysis-DefaultGBRENU 19/01/2020 15:40 ]
Structural Analysis-DefaultMetric 17/01/2020 15:42 I
Structural Analysis-DefaultMetric-Up 17/01/2020 15:42 }
Structural Analysis-DefaultUS-Canada 17/01/2020 15:42 }
Systems-Default_Metric 17/01/2020 15:40 ]
Systems-DefaultGBRENU 19/01/2020 15:40 J
UK Pipe Template 19/01/2020 15:40 I
< >
File name: | Systems-Default_Metric.rte \/|
w Files of type: |Temp\ate Files (*.rte) ~ |
| Open ‘ ‘ Cancel ‘

Después de cargar la plantilla, debe seleccionarla en la ventana Nuevo proyecto y en Crear nuevo marque
la opcidn Proyecto.
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New Project X
Template file
Systems-Default_Metric.rte L
Create new
(@ Project () Project template
OK Cancel Help

Después de abrir la Plantilla es importante definir las unidades de medida que se utilizaran en el proyecto.
Para ello, debe hacer clic en la ficha Administrar, panel Configuracion, y seleccionar la opcion Unidades de
proyecto.

QE Project Parameters !‘E Transfer Project Standards
";j Shared Parameters Qtfl Purge Unused

Q_@ Global Parameters UE Project Units
Settings

A continuacidn, se abrira una ventana donde se muestran las unidades de medida para cada uno de los
parametros. Deberd cambiar el pardmetro Length que se cambiard a Metros, con dos decimales, y también
el pardmetro Slope que se cambiard a Porcentaje. Para areas, volimenes y angulos, también debe definir
dos decimales en la opcidn de redondeo.

Project Units X
Discipline: Commaon ~
Units Format ()
Angle 12.35°
Area 1234.57 m*
Length| 123457 m
Mass Density 123457 kg/m*
Slope | 12.35%
Speed 1234.6 km/h
Time 12346 s
Volume | 123457 m?
Currency 123457
A

Decimal symbol/digit grouping:
123,456,789.00 ~
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Format X
Use project settings
Units: Meters £
Rounding:
2 decimal places v || 0.01
Unit symbol:

m £

[ Suppress trailing 0's
Suppress 0 feet
Show + for positive values

D Use digit grouping

Suppress spaces

Encd

5.4 Modelo de arquitectura de enlaces

Los proyectos MEP se crean normalmente utilizando modelos de arquitectura vinculados. La vinculacion
permite trabajar de forma colaborativa y coordinada entre las disciplinas de la arquitectura y MEP. Si se
modifica el modelo vinculado en el proyecto, Revit actualiza automaticamente el modelo cada vez que se
abre el proyecto.

En este tutorial, utilizarad el modelo de arquitectura que se cred anteriormente en el tutorial de Revit
Architecture. Para vincular, debe ir a la pestafia Insertar y hacer clic en el icono Enlace de Revit.

e B O

Link | Link Link Link DWF
Revit | IFC CAD Topography Markup

A continuacion, aparece una ventana para seleccionar el archivo que se va a importar. Busque el archivo
de proyecto creado en el tutorial de Revit Architecture , seleccidénelo. Para Posicionamiento, especifique

la opcidn deseada, en la mayoria de los casos, debe seleccionar Auto — Origen interno a Origen interno .

Haga clic en Abrir.
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R Import/Link RVT

“
=

lews -

x
=

V|" 2 X

Look in: | [ Area de Trabalho
Preview

Nome
@ OneDrive - Persanal

a
SEste Computador &

" Bibliotecas

Documents ¥ Rede
=z
My Computer
N
jﬂ Architecture
-

My Netwo...

Favorites

File name: ‘

Files of type: |RVT Files (=.nvt)

Fositioning: | Auto - Internal Origin to Internal Origin

Cancel

o |7

El modelo vinculado se mostrara en el area de dibujo.

Cada vez que el cursor del ratén se desplaza sobre el dibujo de Vinculo del modelo de arquitectura,
aparece una casilla de verificacion azul. A veces estas lineas azules dificultan la visualizacion del proyecto.



Co-funded by the

3 Revit MEP Erasmus+ Programme
of the European Union

RVT Links : Linked Revit Model : Architecture.rvt : 2
ocation <Not Shared>

Para deshabilitar la seleccidn de plantillas vinculadas, debe hacer clic en el icono Seleccionar vinculos en
la barra de filtro de verificacién para que la casilla de verificacidén esté inactiva.

[#]E & 0% % @ Fo
5.5 Aiadir niveles

La plantilla predefinida (Systems-Default Metric) proporciona solo 2 pisos (Nivel 1 y Nivel 2), y
dependiendo de la necesidad de cada proyecto puede ser necesario crear mas.

Al abrir una de las vistas Elevaciones por el Explorador de proyectos, puede ver los niveles de la plantilla
y los niveles de la plantilla importada (Sotano, Planta baja y Techo) también son visibles.

Los niveles del modelo de arquitectura importado son solo una representacion grafica y no se pueden
utilizar como referencia en el proyecto actual. Todos los elementos del modelo importado estan en un
solo bloque, lo que hace que sea imposible de cambiar, por lo que debe ingresar niveles que se
superpongan a los del modelo de arquitectura en el proyecto actual.

Roof
6.00m @
Level 2
_ 400m @

Ground Floor
2.60m @

Level 1 Basement
0.00 m @ 0.00 m G




Co-funded by the
3 Revit MEP Erasmus+ Programme
of the European Union

Se recomienda que el Nivel 1y el Nivel 2 pasen a llamarse "Sétano" y "Planta Baja" respectivamente, y
gue sus alturas se cambien para que estén en la parte superior de los niveles del dibujo importado (0,00
my 2,60 m). Crea un tercer nivel y ldmalo Techo, con una altura de 6.00 m.

Para crear este nuevo nivel, el Techo, en la pestaiia Architecture, panel Datum, haga clic en Level.

Cuando se acerque al cursor del ratén desde el nivel de la planta baja, aparecera una dimensién temporal
en relacion con el nivel de la planta baja, que sirve como vista previa del nivel que se va a insertar.
Dependiendo del movimiento del ratdn, la dimensidn cambia.

Ground Floor @
260m

Basement
- © 0.00m @

En relacién con la planta baja, el nuevo piso tendra 3,40 m. Después de ver la dimension temporal de 3,40
m, simplemente haga clic en el area de dibujo y se insertara el nuevo nivel.

_ _ _ _ _ _ _ _ Roof S
6.00m

_ _ - _ _ i — EUUFIG Floor G
260m

_ 1 _ _ _ _ _ 75656”]&“[ G
0.00m
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Ademas de crear un nivel para cada piso del edificio, también puede crear niveles de referencia, como el

nivel del alféizar.
5.6 Sistemas de distribucidn de agua

El sistema de agua sanitaria se divide en los siguientes sistemas: Agua Fria, Agua Caliente y Alcantarillado
Sanitario. En este tutorial se le dard un ejemplo de la creacién de un sistema doméstico de agua fria.

5.6.1 Equipo sanitario

Antes de comenzar la creacidn de un sistema, es necesario insertar equipos sanitarios, como lavabos,
inodoros, bafieras, etc. Aunque estos elementos ya se han afiadido al modelo de Arquitectura, cuando la
arquitectura se inserta a través del enlace de Revit todos sus elementos estan en un solo bloque, lo que
hace imposible cambiarlo. Por lo tanto, es necesario insertar la familia en el disefio hidrdulico
nuevamente, superponiéndose al de la arquitectura.

Por lo tanto, en el Navegador de proyectos, abra la vista "1- Fontaneria", que corresponde a la planta del
sotano (si es necesario, es posible cambiarle el nombre).

Project Browser - Projeto MEP X
=10, Views (Discipline)
Electrical
Mechanical
= Plumbing
777
HVAC
= Plumbing
[=-~Floor Plans
1 - Plumbing
2 - Plumbing
3D Views
Elevations (Building Elevation)
ﬂ Legends
™ Schedules/Quantities (all)
Sheets (all)
917 ramilies
[O] Groups
&8 Revit Links

En la pestafia Sistemas, en el panel Fontaneria y tuberias, haga clic en el icono Accesorio de fontaneria.

S & ETE

Pipe Pipe Parallel ﬁi Plumbing prinkler
Placeholder Pipes QQ, Fixture v
R ——
Plumbing & Piping ¥

En la ventana Propiedades apareceran algunos equipos seleccionados por Revit. Para cambiar el equipo
seleccionado, simplemente haga clic en la imagen / descripcién del elemento.

10
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Properties X
. M_Sink - Island - Single 4
455 mmx455 mm - Public
New Plumbing Fixtures ~ Edit Type
Constraints all ~
Schedule Level Level 1
Elevation from Level 0.0
Host <not associated -
Plumbing A
Flow Pressure ESSW 58.000000 Pa :
Mechanical 0
System Classification Domestic Cold Water,Do..
System Type Undefined
System Name
System Abbreviation

Identity Data =
Properties help Apply

A continuacion, se abrird el Selector de tipos, donde aparecerd una lista de varias familias de equipos Revit.
Utilice la barra de desplazamiento para ver todas las piezas disponibles.

M_Sink - Island - Single
455 mmx455 mm - Public

liea(ch

| £V INIT SUINED = DU 1 Urdin

250 mm Strainer - 80 mm Drain

250 mm Strainer - 100 mm Drain
. M_Sink - Island - Single

455 mmx4355 mm - Private

[ 455 mmess mm - Public

‘ M Sink - Kitchen - Double

1065 mmx535 mm - Private

1065 mmx535 mm - Public

. M_Sink - Mop

710 mmx710 mm

‘ M_Urinal - Wall Hung

20 mm Flush Valve

25 mm Flush Valve

Q M_Water Closet - Flush Valve - Wall Mounted
Private - 6.1 Lpf
Private - Flushing Greater than &.1 Lpf

Public - 6.1 Lpf
Public - Flushing Greater than &.1 Lpf

Para este ejemplo, no se utilizard ninguno de los equipos que aparecen inicialmente en la lista Selector
de tipos porque se cargardn nuevas familias. Para hacer esto, después de hacer clic en la pestaiia sin
sistemas y el icono Accesorio de plomeria, |a pestafia Modificar se abrird | Coloque Accesorio de plomeria
y, @ continuacidn, debe hacer clic en Cargar familia.

11
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Manage Add-lns  Moadify | Place Plumbing Fixture

B | & © ©

Load | Model [Place on| Place on Tag on
Family [In-place Face |Work Plane Placement

Mode Placement Tag

Se abrird la ventana Familia de carga, donde debera acceder a la siguiente ruta:
ProgramData/Autodesk/RVT 2022/Libraries/English/Plumbing/MEP/Fixtures. Dentro de la carpeta
Fixtures, hay varias carpetas nombradas segun el tipo de equipo. Abra la carpeta Armarios de agua.

R Load Family ? X

Lookm:| Fixtures "| <= ._'+ X B views ~

Preview

Nome Tipo

Water Closets
Urinals

Sinks

Showers
Lavatories
Emergency Fixtures
- Drinking Fountains
Drains

Connectors
Bathtubs
Appliances

My Computer

File name: | V|

Files of type: |AII Supported Files (*.rfa, *.adsk) ~ |

| Open | ‘ Cancel |

Al abrir la carpeta Armarios de agua, aparecen algunas familias de elementos de esta clasificacion.
Presionando la tecla CTRL, seleccione las familias: "M_Water Closet — Flush Tank"y "M_Bidet" y haga clic
en Abrir para cargarlas en el proyecto.

12
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R Load Family ? X
Look in: Water Closets v | dm n x | Views -
= ) Preview
- ~ | Nome Tipo
== _
= M_Water Closet - Quiet Flush Tank
M_Water Closet - Flush Valve - Wall Mounted
M_Water Closet - Flush Valve - Floor Mounted
E 1R M Wiater Closet - Flush Tank
M_Bidet
T
2
L
i
File name: | M_Water Closet - Flush Tank.rfa v
v Files of type: | All Supported Files (*.rfa, *.adsk) ~
Tools A Open Cancel

Repita el mismo proceso para cargar las siguientes familias:
e Fregaderos:
- M_Sink - Trabajo
- M_Sink — Servicio
e Duchas:
- puesto de M_Shower — Rectangular
Nota: En la ventana Propiedades, duplique el elemento y cree otros cuatro nuevos con las siguientes
dimensiones:
1,60mx 1,00 m
1,30mx 1,30 m
1,45mx 0,90 m
1,20mx 0,90 m
e lavabos:
- M_Lavatory - Rectangular
e Bafieras:
- M_Tubo de bafio — Maestro
Nota: En la ventana Propiedades, haga clic en Editar tipo y cambie los pardmetros ancho del tubo de bafio
a 1,10 my Longitud del tubo de bafio a 2,50 m.
e Aparatos:
- M_Washing Maquina
- M_Dishwasher

Después de cargar todas las familias, puede insertar estos elementos en la vista. No marque el panel
Sistemas, fontaneria y tuberias, haga clic en el icono Accesorio de fontaneria. Ahora, en la ventana
Propiedades, todas las familias cargadas aparecen en el Selector de tipos. Seleccione el tipo "Privado - 6.1
Lpf" de la familia "M_Water Cerrado - Tanque empotrado".

13
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. . ‘
Properties X [ 2-Plumbing X

M_Water Closet - Flush Tank o u@
Private - 6.1 Lpf
[search Pl
25 mm Flush Valve ~
' M_Water Closet - Flush Tank
\ Private - 6.1 Lpf

Private - Flushing Greater than 6.1 Lpf M_Water Closet - Flush Tank
Public - 6.1 Lpf
Public - Flushing Greater than 6.1 Lpf
Q M_Water Closet - Flush Valve - Wall Mounted
Private - 6.1 Lpf
Private - Flushing Greater than 6.1 Lpf
Public - 6.1 Lpf
Public - Flushing Greater than 6.1 Lpf

. M_Whirlpool Spa

Mast Recentiv | I Tunes

Con el elemento seleccionado, amplie el cursor donde desea insertarlo. Para girar el objeto, puede utilizar
la barra espaciadora del teclado. Cuando el objeto esté posicionado, simplemente haga clic en el dibujo
para insertarlo.

15.0 mim

2207y

Al hacer clic en el equipo insertado, la ventana Propiedades identifica el objeto y se pueden realizar
cambios en cada proyecto. Cerca del objeto, aparecen las identificaciones de las conexiones de suministro
de agua y drenaje.

14
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Inserte todos los demads elementos con la siguiente distribucidn:

Vista: 1- Fontaneria (planta do piso Sétano):

WC 1:
= M_Water Closet — Tanque empotrado — Privado 6.1 Lpf
= M_Llavatory — Rectangular — Privado — 560 mmx560 mm
= M_Shower — Rectangular - 1,60 m x 1,00 m - Privado
WC 2:

= M_Water Closet — Tanque empotrado — Privado 6.1 Lpf
= M_Lavatory — Rectangular — Privado — 560 mmx560 mm
= M_Shower — Rectangular - 1,45 m x 0,90 m — Privado

[&]
we2 [

Vista: 2 - Fontaneria (planta do piso Planta Baja):

15
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- Bafio1:
= M_Water Closet — Tanque empotrado — Privado 6.1 Lpf
= M_Bidet
= M_Bath — Maestro — Privado
= M_Lavatory — Rectangular — Privado — 560 mmx560 mm
= M_Shower — Rectangular - 1,30 m x 1,30 m - Privado
- Bafio2
= M_Water Closet — Tanque empotrado — Privado 6.1 Lpf
= M_Lavatory — Rectangular — Privado — 560 mmx560 mm
= M_Shower — Rectangular - 1,60 m x 1,00 m - Privado
- Bafo3
= M_Water Closet — Tanque empotrado — Privado 6.1 Lpf
= M_Llavatory — Rectangular — Privado — 560 mmx560 mm
= M_Shower — Rectangular - 1,20 m x 0,90 m - Privado
- Cocina:
=  M_Sink — Trabajo
= M_Dishwasher
- INODORO:
= M_Water Closet — Tanque empotrado — Privado 6.1 Lpf
= M _Lavatory — Rectangular — Privado — 560 mmx560 mm
- Lavadero:

= M_Sink — Servicio
- Almacenamiento:
= M_Washing Maquina

7///////////////4 V.2 7] A ZLLZTTTZZTGT LT ZZT
%

NN

STORAGE
KITCHEN
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%
wc .|;. ROOM |/
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H
H
7
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> Nota: Para el elemento "M_Sink - Trabajo", debe editar la elevacion en relacién con el piso.
Para ello, seleccione el elemento y en la ventana Propiedades, en el campo Elevacion desde

nivel, rellene con el valor de 0,80 m.
Properties X

M_Sink - Work
510 mmx455 mm

Plumbing Fixtures (1) ~ | H8 Edit Type
Constraints Gl A~
Level Ground Floor
Elevation from Level 0.8000 m
Host Level : Ground Floor
Offset from Host 0.8000 m
Plumbing )
Flow Pressure 551 58.000000 Pa
Mechanical
System Classification éDo"nest'c Cold Water.Do...é Y]
Properties help Apply

5.6.2 Creacion de un sistema doméstico de agua fria

Después de insertar todo el equipo sanitario, puede comenzar a crear el rastreo de la red de agua fria.
Para hacer esto, haga clic en uno de los equipos sanitarios insertados y luego haga clic en el icono Tuberia
en la pestafia Modificar.

Modify | Plumbing Fixtures

2 | &5
Connect Piping
Into

1 Layout Create Systems

Aparecera la ventana Crear sistema de tuberias, en la que en Tipo de sistema debe seleccionar la opcion
Agua fria doméstica, en el campo Nombre del sistema puede cambiar el nombre del sistema (en este
caso se mantendrd ), y debe marcar la opcion Abrir en el Editor del sistema. Después de esta
configuracién, haga clic en Aceptar.

Create Piping System ? X

System type: Domestic Cold Water ~

System name: | Domestic Cold Water 1

[]Open in System Editor

17
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Seleccione la herramienta Agregar al sistema para agregar el resto del equipo al sistema.

- (GaD) =
k[ E 1662 & ¢ X
Modify |Properties Add Remove Select Finish Cancel
to System ffrom System | Equipment Editing System Editing System

Select » Properties Edit Piping System Mode

Acerque el cursor del mouse y haga clic en todo el equipo sanitario en las plantas del sotano y la planta
baja.

Después de seleccionar todo el equipo, haga clic en Finalizar sistema de edicion ¥ .

Hay dos formas de rastrear las tuberias: manualmente o a través de soluciones automaticas generadas
por Revit, que se pueden personalizar.

Para generar automaticamente, simplemente haga clic en uno de los elementos que se han agregado al
sistemay en el [ Accesorios de plomeria, haga clic en el icono Generar disefio.

Modify | Plumbing Fixtures  Piping Systems

LI s

Generate] Generate Connect Piping
Layout JPlaceholder Into

1 Layout Create Systems

Revit leera los elementos que se han agregado al sistema y generard soluciones a partir de la disposicion
de estos elementos, en las que las tuberias y conexiones se insertan automdaticamente. Se abre la pestafia
Generar disefio, donde aparecen algunas herramientas de edicion.

—iF
E I:/ Slope Value: W X
Remave Place 0.0000% ~  Finish Cancel
from System Base Layout Layout
Modify Layout Slope Generate Layout

Generate Layout Solution Type  Network v 2of2 @ I

En la barra Generar disefio, puede seleccionar el tipo de solucion en Tipo de solucion, que puede ser red,
perimetro o interseccion, segun las preferencias del disefiador. En este ejemplo, se mantendra la opcion

18



Co-funded by the
3 Revit MEP Erasmus+ Programme
of the European Union

Red. Ademas del tipo de solucidn, esta el nimero de soluciones generadas por Revit, en este caso se

generaron dos.

Generate Layout Solution Type  Network ~ 2of2 4l Ik Settings ...

El modelo de disefio generalmente establece las elevaciones y los tipos de tuberias, asi como sus
diametros. Sin embargo, es posible que deba especificar los tipos de tuberia estandar y las elevaciones
para la tuberia del sistema.

Al hacer clic en Configuracion, se abre la ventana Configuracion de conversién de tuberia. En el elemento
Principal, en el parametro Tipo de tuberia, seleccione el material "PVC - DWV" y desvie, establezca el
valor de -0.20m, de modo que las tuberias pasen por debajo de la losa. Para que el elemento Branch
realice los mismos cambios.

Pipe e & *
[wain ]
Branch System Type: Domestic Cold Water
Setting Value
Pipe Type Pipe Types: PVC - DWV
Offset -0.2000 m
0K Cancel

Una de las soluciones generadas por Revit fue la representada en la imagen de abajo (Solucién 1/2 tipo de red).
Sin embargo, se puede observar que no es la solucién ideal y es necesario hacer algunos ajustes. Debido a que
es una solucidon automatica generada por software, puede haber diferencias de una computadora a otra, e
incluso mas soluciones.
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Para editar la solucién, haga clic en Editar disefio.

a

Remove
from System

Modify Layout

Con esta herramienta puede arrastrar las tuberias insertadas y reposicionarlas en el Sistema. En este
caso, no se realizard ninguna edicion, ya que los ajustes también se pueden realizar manualmente fuera
de la edicidn del disefio.

Los diametros de las tuberias y conexiones también se cambiardn mds adelante, por definicién todos
tienen 15 mm de diametro.

Haga clic en Finalizar disefio para completar.

v X

Finish Cancel
Layout Layout

Generate Layout

Al final, pueden surgir algunos errores, uno de los cuales puede deberse a alguna conexién que se ha
dejado abierta segun la siguiente imagen.
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This element has an open connection. This may not be an error, but for flow
calculations to work correctly all connections should be sealed with an end cap.

El error anterior puede estar relacionado con otro error porque no hay espacio para la colocacién de
accesorios.

Warning: 3 out of 4

There was not enough room to place the required fittings. Consider increasing
the length of the segments, or moving them farther apart to generate a solution.

Cuando se muestran las ventanas de error, el elemento se resalta en el plano para que se pueda verificar.
Por el momento debe continuar, ya que los errores se corregirdn mas adelante.

Desde el Navegador de Proyectos, se debe acceder al plano de planta "2- Fontaneria" correspondiente al
piso de Suelo. Como el sistema se ha insertado a -0,20 m por debajo de la losa de este piso, no serd visible
en esta vista. Para que sea visible, en la ventana Propiedades, en el parametro Rango de vista, haga clic
en Editar.

Properties
E:l] Floor Plan -
Floor Plan: 2 - Plumbing « |tz Edit Type
Sun Path D
Underlay
Range: Base Level Basement
Range: Top Level Unbounded
Underlay Orientation Look down
Extents 2
Crop View ]
Crop Region Visible ]
Annotation Crop ]
| View Range Edit...
Associated Leve Ground Floor
Scope Box Mone
Depth Clipping Nao clip
Identity Data A v
Properties help Apply
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A continuacion, se abrird la ventana View Range. En View Depht, cambie el pardmetro Level a
"Unlimited)" vy, a continuacién, haga clic en OK.

>

View Range

Primary Range

Top: Associated Level (Ground F Offset: | 4.0000 m
Cut plane: Associated Level (Ground F Offset: | 1.2000 m
Bottomn: Associated Level (Ground F ~ Offset: | 0.0000 m

View Depth

Level: Unlimited ~ Offset: | 0.0000 m
Learn more about view range

<< Show Apply Cancel

Por lo tanto, todo el sistema es visible en la vista de este piso.
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Un consejo importante que ayuda a mejorar la visualizacién de los elementos, es disminuir el grosor de
las lineas de contorno. Para ello, debe hacer clic en la herramienta Lineas delgadas, ubicada en la barra
de herramientas de acceso rapido.

REEGHG -&-~-8 2-F0A G-2IFE]N0-+

Otro consejo que puede ayudar con la visualizacion grafica es establecer el nivel de detalle con la opcién
Fino vy el estilo visual en Color realista o consistente.
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A partir del disefio de la red generado automaticamente por Revit, se realizardn ediciones manuales para
adaptarla mejor, de modo que las tuberias estén optimizadas. Para este sistema hidraulico no solo hay
una solucién de disefio, por lo que el rastreo de la red varia segun las preferencias de trabajo.

Como ejemplo de demostracién, se editara la region del sistema que se muestra en la imagen a
continuacién. Se sugiere que el disefio de las otras regiones también se edite de acuerdo con las
preferencias.

Para ayudar a realizar un seguimiento de la configuracidn del sistema, puede abrir vistas de elevacion a través

del Explorador de proyectos y también crear vistas de seccion mediante la herramienta Secciones @ de la
barra de herramientas de acceso rapido.

Para empezar, en el Bafio 1, se eliminaran las conexiones Bidé y Inodoro, como se muestra en la siguiente
imagen. Para eliminar un elemento, simplemente haga clic en él y presione la tecla eliminar. Compruebe
la vista 3D para ver si se han eliminado todas las conexiones.

23



Co-funded by the
V ET3 Revit MEP Erasmus+ Programme
of the European Unicn

Para iniciar el rastreo de red manualmente, debe seleccionar uno de los elementos y hacer clic en el
icono "Entrar" del equipo.

/)

15.0 mm

150 AU

Luego aparecera una linea que representa el trazado de la tuberia, que se mueve de acuerdo con el
movimiento del cursor del mouse. Observe la dimensidn temporal e inserte los 0,10 m en la pared.
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En la pestafia Sistemas, panel Fontaneria y tuberias, seleccione la herramienta Tuberia.

o
N,
o,
h
—
=

Pipe

Pipe

= R
Parallel ﬁl

Placehclder Pipes %

Plumbing Sprinkler
Fixture

Plumbing & Piping El

En la ventana Propiedades, compruebe que el tipo de tuberia "PVC - DWV" esté seleccionado.

Properties X
~ Pipe Types -
PVC - DWV

Pipes (1) | £3 Edit Type
Constraints A oA

Horizontal Justification {Center

Vertical Justification Middle

Reference Level Basement

Top Elevation 24107 m

Middle Elevation 24000 m

Bottom Elevation 23893 m

Start Middle Elevation 124000 m

End Middle Elevation 24000 m

Slope 0.0000%
Dimensions &

Cutside Diameter 21.3 mm

Inside Diameter 15.8 mm

Size 15 mmg R
Properties help Apply

En la barra de opciones, compruebe que el didmetro de 15 mm esta seleccionado.

W adify | Pipes

Con esto, amplie el cursor del mouse desde el final de una de las conexiones ya insertadas y arrastre a la

otra para conectar los dos objetos.

Diameter:

15.0 mm w
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[Point. 15 mm @ 026 m

B

También se eliminara la tuberia que pasa por debajo del inodoro y se dibujard una nueva, con la
herramienta Tuberia, para que esté alineada con la tuberia en el otro extremo.

Debe seleccionar la tuberia y eliminarla antes de crear la nueva.

Desde la vista 3D, con Visual Style en la opcidn Realista, al hacer zoom en el ratén desde el otro extremo,
se observa que algunas conexiones se mantuvieron con tres salidas.
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Para eliminar una de las salidas, simplemente haga clic en la conexién y luego en el icono para eliminar.

En este caso, al tratarse de una conexion corta y recta, la conexion se eliminara por completo.

s b

15.0 mm

15.0 mm

15.0 mm O

También es posible que deba agregar una salida mds a alguna conexién, como la conexién que conectara

la nueva tuberia al inodoro. Para hacer esto, haga clicen el icono en la direccion deseada.
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15.0 mm

=

4=

En la ficha Sistemas, seleccione la herramienta Tuberia y haga clic en la nueva salida creada para la
conexion, en la barra de opciones, debe introducir el valor de -0,20 en Elevacion media.

Middle Elevation:| -0.2000 m v| Apply

Arrastre la tuberia desde la toma de conexion hasta la pared de la conexién del inodoro, como se muestra
en las siguientes imagenes.
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M

| Horizontal and Extension i

i

Para alinear las tuberias, simplemente seleccione una de ellas y en la | Las tuberias seleccionan la
+*

. Lihd . . , .
herramienta Mover * . Seleccione el punto en el medio de la nueva tuberia y luego el punto medio de la
tuberia de inodoro.

[
[
[
[
[
[
[
[
[
[
|
A continuacion, debe seleccionar la conexién y presionar la tecla supr para eliminarla.
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Para unir las tuberias se utilizara una herramienta muy util para realizar estos procesos en Revit, que es

-
= . . . - . .
la  "herramienta Trim/Extend to Corner. Esta herramienta se puede utilizar siempre que sea necesario

conectar tuberias. Para ello, debe seleccionar una de las canalizaciones y en la | Tuberia, seleccione la
herramienta Recortar /Extender a esquina.

+. 0O
4'3* Q)

Modify

Con la herramienta seleccionada, simplemente haga clic en las dos tuberias y la conexion se agregara

automaticamente.
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Los otros equipos también se conectaran de manera mas éptima, como los lavabos. Este tipo de lavabo
tiene por definicién un didmetro de 25 mm para la conexion de agua fria. Debe realizar el cambio de esta
medida haciendo clic en el elemento y en la ventana Propiedades haga clic en editar tipo.

Properties X

M_Lavatory - Rectangular
560 mmx560 mm - Private

Plumbing Fixtures (1) v| Edit Type
Constraints A oA
Schedule Level Ground Floor

Elevation from Level 0.8650 m
Host Linked Revit Model : Praj...
Plumbing B
Flow Pressure 155158.000000 Pa ]
Mechanical B
System Classification Domestic Cold Water,Do...
System Type Domestic Cold Water
System Name Domestic Cold Water
System Abbreviation
Identity Data B
Image

Comments v
Properties help Apply
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Se abrird la ventana Propiedades de tipo y deberd cambiar el pardmetro Diadmetro de agua fria a 15 mm.

Type Properties X

Family: |M_lavaloly - Rectangular > ‘ Load...
Type: |5-60 mmx560 mm - Private ~ ‘ Duplicate...

Rename...

Type Parameters

| Parameter Value ‘ =‘ 2

Default Elevation 0.8650 m

Sink Material <By Category>

Faucet Material <By Category=> D
Pimensions &
Sanitary Radius 16.0 mm 'l
Sanitary Diameter 32.0 mm

Sink Width 0.3810 m

Sink Length 03050 m | ]
Lavatory Length 0.5600 m []
Lavatory Width 0.5600 m

Hot Water Radius 7.5 mm

Hot Water Diameter 15.0 mm [
Cold Water Radius 7.5 mm []
Cold Water Diameter 15.0 mm ;

What do these properties do?

o e |

Al igual que con el bidé y el inodoro, los dos lavabos se conectaran para optimizar la tuberia. Luego se

i n

deben excluir las conexiones de los lavabos y luego crear nuevas conexiones con la herramienta " In
del equipo.
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Utilizando las herramientas mencionadas, conecte la ducha, la bafera, los lavabos, el bidé y el inodoro en
una configuracién similar a las siguientes imdagenes.

Se recomienda realizar cambios similares en otras regiones del sistema para que se creen mejores

soluciones para que esté mejor distribuido.

Para ayudar a realizar un seguimiento de la configuracién del sistema, puede abrir vistas de elevacion a
través del Explorador de proyectos y también crear vistas de seccion mediante la herramienta Secciones

de la barra de herramientas de acceso rapido. @

Una de las posibles soluciones puede parecerse a las imagenes a continuacién
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Con el sistema de distribucion de agua ya estructurado en los entornos de vivienda, se debe establecer
una conexion del sistema constructivo con la red publica. En este proyecto no se representa la ubicacion
del punto de la red publica, por lo tanto, se realizara una aproximacion.

El punto en el que la tuberia de conexién a la red publica se conectard al sistema estd marcado en rojo en
la imagen a continuacion.
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Para comenzar a rastrear la seccion de conexion a la red publica, debe abrir la vista "2 - Fontaneria",
correspondiente a la Planta Baja.

En la pestafia Sistemas, panel Fontaneria y tuberias, seleccione la herramienta Tuberia .

Q| & =2 B X

Pipe Pipe Parallel ﬁu Plumbing Sprinkler
Placehclder Pipes ';;}, Fixture

Plumbing & Piping El

En la barra de opciones, cambie el pardmetro Didmetro a 40 mm vy elevacion media a -0,40 m.

Modify | Place Pipe Diameter:| 40.0 mm v Middle Elevation: | -0.4000 m v

En el plano de planta, acérquese al cursor del mouse desde el drea rodeada de rojo en la imagen anterior
y trace un pequeiio tramo de tuberia hasta aproximadamente la mitad de la pared, segin la imagen a
continuacion.
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Elimine la conexion existente entre las dos tuberias, haga clic en el extremo de la tuberia horizontalmente
y arrastrela hasta el encuentro con la nueva tuberia de 40 mm.

0 ZGLG m
_

Se creara automaticamente una conexién entre las dos tuberias, ya con el reductor de didmetro (de 40
mm a 15 mm) acoplado.
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Para volver a conectar la tuberia en la direccion vertical, haga clic en ella y arrdstrela hasta que esté con
la tuberia que se conecté anteriormente.

Las conexiones en esta drea deben parecerse a la imagen de abajo.

Ahora debe arrastrar la tuberia hasta el limite del terreno. Para hacer esto, abra la vista 3D y en el cubo
de vista previa haga clic en TOP para ver el dibujo desde arriba, al igual que en una vista de plano. La
diferencia es que en la vista 3D se pueden ver los limites del terreno.

Con esto, haga clic en el extremo de la tuberia de 40 mm vy arrastrela diagonalmente hasta que esté con
el limite del terreno.
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Después de extender la tuberia, haga clic en ella para seleccionarla. En el /| Modificar Tuberias, panel

Editar, seleccione la opcidn Tapa abrir extremos para cerrar el extremo no conectado de esta tuberia,

porque la conexidn a la red publica la realiza la compafiia de agua local

:ﬁa
Cap
Open Ends

La apariencia debe ser similar a la imagen de abajo.
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Después de estructurar toda la red, se deben realizar algunos cambios en los didmetros y conexiones en
algunas secciones. En la siguiente imagen, se identifican las secciones que requieren cambios de diametro.
Las secciones con verde, deben cambiarse a 40 mm y las secciones de color amarillo a 25 mm. El resto
debe mantenerse con un diametro de 15 mm. .
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El cambio se realiza de forma muy sencilla, basta con hacer clic en la tuberia que se desea cambiary en el
parametro Modificar tuberia en el pardmetro Diametro seleccionar el valor deseado (25mm o 40mm).

Es muy importante comprobar que al cambiar el didmetro de la tuberia, el didametro de la conexién ha
cambiado automaticamente. Si no ha cambiado, haga clic en la conexién y en modificar conexiones de
tuberia en el paradmetro Diametro para seleccionar el valor deseado (25 mm o 40 mm).

5.6.3 Anotagoes

Para insertar elementos de anotacion, como identificadores de didametro de tuberia, debe acceder a la
ficha Anotar, al panel de etiquetas y seleccionar la herramienta Etiqueta por categoria.

oy
[
Tag by
Category
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Con la herramienta seleccionada, haga zoom en el cursor del raton del elemento a identificar y aparecera
el texto identificativo, con el didmetro correspondiente al elemento. Coloque el texto como desee y haga
clic en el elemento para insertar el ID.

‘ |

15 mMmg

[ Pipes: pipe Types : PVC - DWWV |

i

En este caso, el texto se hizo demasiado grande para la escala del dibujo. Para cambiar el tamafio del
texto, debe hacer doble clic en el texto y, a continuacidn, en el | Etiqueta. Haga clic una vez en el texto
"Tamano" para seleccionarlo.

Size

Con el texto seleccionado, en la ventana Propiedades , haga clic en Editar tipo.

Properties X
Label .
25
Pipe Tags (1) « | H8 Edit Type
Graphics R oA
Sample Text Size...
Label | Edit...
Wrap between paramet...:[ ]
Horizontal Align Center
Vertical Align Middle
Keep Readable [ ]
Visible [ ]
. L
Properties help Apply
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Type Properties X
Family: System Family: Label ~ Load...
Type: ZE b Duplicate...

Rename...
Type Parameters
Parameter ‘ Value ‘ :|
Graphics B
Color . Black
Line Weight 1
Background Opaque
Show Border O
Leader/Border Offset 2.0320 mm
Text A
Text Font Arial
Text Size WEmm
Tab Size 12.5000 mm
Bold ]
Italic O
Underline O
‘Width Factor 1.000000
What do these properties do?
<< Preview Cancel Apply

Después de editar el tamano del texto, en el panel Editor de familia, haga clic en el icono Cargar en
proyecto.

Edit JLoad into Load into
Label § Project JProject and Close

Label Family Editor

Aparecera una ventana advirtiendo que la Familia ya existe, haciendo clic en la opcidén "Sobrescribir la
version existente".
Family Already Exists X
You are trying to load the family M_Pipe Size Tag, which
already exists in this project. What do you want to do?
—» Overwrite the existing version

—» Overwrite the existing version and its parameter
values

Cancelar

Click here to learn more
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Ahora el texto es de un tamafio mas apropiado, si es necesario, puede editarlo nuevamente para
aumentar o disminuir ain mas el texto.

Para arrastrar el texto a lo largo de la tuberia que representa, debe hacer clic en el icono ubicado justo

.
debajo del texto y arrastrarlo a la ubicacion deseada. +

15 mmg

Realice el mismo procedimiento para todas las tuberias para que sea similar a la siguiente imagen.

15 mma

H:15 mmg 15 mme /JJ__

También puede utilizar la herramienta Etiquetar todo en la pestafia Anotar.

[ @

Tag by | Tag
Category| All
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En la ventana Etiquetar todo no etiquetado, seleccione la opcién Etiquetas de tuberia en la columna
Categoria.

Tag All Not Tagged X

Select at least one Category and Tag or Symbol Family to annotate
non-annotated objects:

(®) All objects in current view
Only selected objects in current view

[ Jinclude elements from linked files

Category Loaded Tags 2
[ [Mechanical Equipment Tags M_Mechanical Equipment Tag :
[ FNurse Call Device Tags M_Nurse Call Devices Tag
Pipe Tags M_Pipe Size Tag
[ FPlumbing Fixture Tags M_Plumbing Fixture Tag : Boxe
[ fRoom Tags M_Room Tag : Room Tag
[T Security Device Tags M_Security Devices Tag
[ |Space Tags M_Space Tag : Space Tag
[ Sprinkler Tags M_Sprinklers Tag
[ Telephone Device Tags M_Telephone Device Tag
™ izl Tamc KA VA3l Tam s 12mm >
[veader Leader Length: 12.7 mm
Tag Orientation: |Horizontal e
0K Cancel Apply Help

Al hacer clic en Aceptar, los identificadores se agregan a todas las canalizaciones existentes en el proyecto.
Sin embargo, muchos textos eventualmente se superponen y los ajustes manuales deben hacerse de
cualquier manera.

5.6.4 Crear tablas
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La creacion de tablas para Revit MEP se realiza de la misma manera que para Revit Architecture, cuyos
cambios son la informacién que se muestra en cada tipo de tabla. Para ejemplificar, se creard una tabla

en la que se contiene informacion sobre las tuberias.

Para comenzar a crear una tabla, en el explorador de proyectos en Programaciones, haga clic con el botdn
secundario y, a continuacidn, seleccione la opcién Nueva programacién/Cantidades. .

New Schedule/Quantities...

Properties help Mew Graphical Column Schedule...
New Material Takeoff...

Project Browser - MEP automatis New Sheet List..

B 3D Views i MNew Mote Block...
3D Plumbin New View List
£ Elevations (Buil W VIEW LISt
East - Plumi Browser Organization...
North - Plur Search...
South - Plui Expand Al
West - Plum

=| Legends Collapse Selected

=] : Collapse All
Space Outdoor Air Schedule
Sheets (all)
9 Families
=-[@] Groups
Detail
Model

A continuacién, en la ventana Nueva programacion, en Categoria, seleccione la opcién Tuberias. En
Nombre, puede cambiar el nombre de la tabla, en este caso se mantendrd "Programacion de tuberias".

New Schedule X
Category: Name:

MEP Fabrication Hange... A | Pipe Schedule
MEP Fabrication Pipew...

Model Groups (@) Schedule building components

Parts
Pipe Accessories (O schedule keys

Pipe Fittings

Pipe Insulations

Pipe Placeholders

Phase:
Piping Systems

Plumbing Fixtures

Rooms

RVT Links b

New Construction b
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En la ventana Propiedades de programacién de la ficha Campos, seleccione los siguientes pardmetros

para la tabla: Tipo de conexion, Diametro, Flujo, Longitud, Material, Nombre del sistema, Elevacion
superiory Velocidad.

Schedule Properties X

Fields Filter Sorting/Grouping Formatting Appearance

Select available fields from:

Fipes e

Available fields: Scheduled fields (in order):

Additional Flow ~ Connection Type

Assembly Code Diameter
Assembly Description Flow
Assembly Name Length
Bottom Elevation Material
Comments System Name
Cost Top Elevation
Count Velocity
Critical Path
Description
Family

Family and Type
Fixture Units &
Flow State d
Friction
Friction Factor Jx
focGUID

Image hd E

i

[Jinclude elements in links

Al hacer clic en Aceptar, se creara la tabla con toda la informacién que se haya seleccionado. Si se realiza
un cambio en el proyecto, la tabla se actualiza automaticamente y viceversa.
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<Pipe Schedule>
A B C D | E | F G H
Connection Type Diameter Flow Length Material System Name Top Elevation Velocity
Generic 15.0 mm 09LUs 038 m Polyvinyl Chloride - :Domestic Cold Water 1022 m 4.8 mfs
Generic 15.0 mm 0.0Lls 3585 m Palyvinyl Chloride - :Domestic Cold Water  -0.19m 0.0 mis
Generic 15.0 mm 09LUs 0.03m Paolyvinyl Chloride - iDomestic Cold Water (0.27 m 4.8 mfs
Generic 15.0 mm 0.9LUs 1.03m Palyvinyl Chloride - :Domestic Cold Water 0.87 m 4.8 mis
Generic 15.0 mm 0.9LUs 0.03m Polyvinyl Chloride - :Domestic Cold Water :0.93 m 4.8 mis
Generic 15.0 mm 09LUs 103 m Polyvinyl Chloride - (Domestic Cold Water (10.87 m 4.8 mfs
Generic 15.0 mm 0.9LUs 0.03m Palyvinyl Chloride - :Domestic Cold Water :0.93 m 4.8 mfs
Generic 16.0 mm 0.9L/s 0.04 m Palyvinyl Chloride - ;Domestic Cold Water (0.48 m 4.8 mis
Generic 15.0 mm 0.9LUs 0.04 m Paolyvinyl Chloride - :Domestic Cold Water 0.93 m 4.8 mfs
Generic 15.0 mm 0.9LUs 1.03m Polyvinyl Chloride - :Domestic Cold Water . 0.87 m 4.8 mis
Generic 15.0 mm 09Us 0.03m Paolyvinyl Chloride - {Domestic Cold Water 1093 m 4.8 mfs
Generic 15.0 mm 0.9LUs 1.50 m Palyvinyl Chloride - :Domestic Cold Water 12.36 m 4.8 mfs
Generic 15.0 mm 0.9L/s 059 m Polyvinyl Chloride - ;Domestic Cold Water 043 m 4.8 mis
Generic 15.0 mm 09LUs 0.03m Polyvinyl Chloride - :Domestic Cold Water 048 m 4.8 mfs
Generic 15.0 mm 0.9LUs 1.03m Palyvinyl Chloride - :Domestic Cold Water 0.87 m 4.8 mis
Generic 15.0 mm 09LUs 0.03m Palyvinyl Chloride - iDomestic Cold Water (0.93 m 4.8 mfs
Generic 40.0 mm 19LUs 14.02m Palyvinyl Chloride - iDomestic Cold Water -0.18 m 1.5 m's
Generic 15.0 mm 0.9LUs 0.06 m Polyvinyl Chloride - :Domestic Cold Water 048 m 4.8 mis
Generic 15.0 mm 09LUs 0.07 m Polyvinyl Chloride - (Domestic Cold Water (1027 m 4.8 mfs
Generic 15.0 mm 0.9LUs 0.04 m Palyvinyl Chloride - :Domestic Cold Water 10.52 m 4.8 mfs
Generic 16.0 mm 0.9L/s 0.04 m Palyvinyl Chloride - ;Domestic Cold Water (0.82 m 4.8 mis
Generic 15.0 mm 0.9LUs 1.76 m Paolyvinyl Chloride - :Domestic Cold Water 0.82 m 4.8 mfs
Generic 15.0 mm 0.9LUs 0.93m Palyvinyl Chloride - :Domestic Cold Water 0.77 m 4.8 mis
Generic 15.0 mm 0.0LUs 037 m Paolyvinyl Chloride - {Domestic Cold Water (-0.19m 0.0 mis
Generic 15.0 mm 0.0LUs 0.38 m Palyvinyl Chloride - :Domestic Cold Water 10.22 m 0.0 m/s
Generic 15.0 mm 0.9LUs 015 m Polyvinyl Chloride - :Domestic Cold Water 043 m 4.8 mis
Generic 15.0 mm 0.0LUs 304 m Polyvinyl Chloride - (Domestic Cold Water (1027 m 0.0 m/s
Generic 15.0 mm 0.0Lls 049 m Palyvinyl Chloride - :Domestic Cold Water 10.27 m 0.0 m/s
Generic 16.0 mm 0.9L/s 0.57 m Palyvinyl Chloride - ;Domestic Cold Water (0.87 m 4.8 mis
Generic 15.0 mm 0.0LUs 0.38 m Paolyvinyl Chloride - :Domestic Cold Water 0.22 m 0.0 m's
Generic 15.0 mm 0.9LUs 0.84 m Polyvinyl Chloride - :Domestic Cold Water :0.27 m 4.8 mis
Generic 40.0 mm 0.0Us 6.77 m Paolyvinyl Chloride - {Domestic Cold Water 1-0.38 m 0.0 mis

5.6.5 Crear vistas isométricas

Para una mejor representacién del proyecto, puede crear vistas isométricas de la red. Para colocar el
dibujo en una vista isométrica, simplemente abra la vista 3D y haga clic en una de las esquinas del cubo,
dependiendo del drea azul en la imagen a continuacién.

Para crear una vista isométrica general de la red, primero debe duplicar la vista 3D. Para ello, en el
Explorador de proyectos, haga clic con el botdn secundario en la vista Fontaneria 3D, luego en duplicar
vista y, a continuacién, duplicar. Cambie el nombre de la vista a "Fontaneria isométrica".
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w 3D View Tt

Open Sheet
3D View: 3D Plumbing Close
Graphics Show Camera
View Scale 1:10 Apply Template Properties...
\ .
Scale value Tt 100 Create View Template From View...
Detail Level Mediy
; - 3 .
Parts Visibility Show | DuplicateView : Duplicate .
Visibility/Graphics Overr... Convert to mdepenc-ient view Duplfcatemth Detailing
Graphic Display Options Apply Deperndent Views.. Duplicate as a Dependent
Discipline Plum Save to Project as Image...
Show Hidden Lines  ByDic  Delete -
Properties help Copy to Clipboard . -
Rename... e 7]
[HTepETi (HEIREr - [/EP aEnmall Select All Instances > Fal - -~
H- HVAC =
= v i P .
S Plumbing Properties @"‘:’/ >
(=] Floor Plans Save to New File... o7
E . E:umE?ng Search...
- PUmBING - pypand All
30 Hems Coll Al
[ > Dl umbind oflapse

= E_Ievations (Building Elevation)
! ast - Plumbing

MNorth - Plumbing

outh - Plumbing

West - Plumbing

Los niveles no serdn necesarios en esta vista, por lo que puede ocultarlos. Para hacer esto, para hacer clic
en uno de los niveles de clic derecho, haga clic en Ocultar en Ver y seleccione la opcidn Categoria.

Cancel

.

4

Repeat [Select links]

Recent Commands >
Drag End

Go to Floor Plan

Maximize 3D Extents

Hide in View > Elements
Override Graphics in View » Category

Create Similar By Filter...

Edit Family

Select Previous

Select All Instances >
Delete

Con la isometria posicionada de acuerdo con la imagen de abajo, la posicidn sera fija.
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Para anclar la posicién en la barra de vista previa, simplemente haga clicen el @ icono Vista 3D bloqueada
y seleccione la opcidén Guardar orientacion y Bloquear vista. La vista entonces no se puede girar.

ﬁ Save Orientation and Lock View

Restore Orientation and Lock View
Unlock View

F Gk &G EESS ¢ cam @la <

Es importante establecer la region de recorte de la vista, de modo que cuando se inserta en una hoja de

-h e .
impresidn ya esté ajustada. Para ello, haga clic en =5 Mostrar region de recorte en la barra de vista
previa.

& kG@ERe o e ard <

Se mostrara el rectangulo con la regién de recorte. Haga clic en el rectangulo y ajustelo para que esté muy
cerca de los limites del dibujo, de acuerdo con la imagen a continuacion.
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R

o

Después de ajustar la regién de recorte, en la barra de vista previa, seleccione la opcién'[g:ul Ocultar

region de recorte para ocultar la regién de recorte.
FFx *xGRElE > o ad &«

Se crea la vista isométrica general. Ahora se creard una vista isométrica de un bano. Para hacer esto,
duplique la vista "Plomeria isométrica" y cambiele el nombre a "Bafio de plomeria isométrica".

Con la vista "Bafio de plomeria isométrica" abierta, haga clic en @ el icono Desbloquear vista 3D y
seleccione la opcion Desbloquear vista para volver a permitir que la vista 3D se mueva.

Save Orientation and Lock View

Restore Orientation and Lock View
’E Unlock View

B Tx Gk o &R

Gire la vista 3D por las esquinas del cubo de vista previa hasta llegar a la vista de acuerdo con la siguiente

imagen. Una vez colocado, vuelva a hacer clic @ en el icono Vista 3D bloqueada. El circulo rojo representa
el entorno para el que se creara la vista isométrica.
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Para recortar la vista isométrica solo desde el entorno deseado, puede utilizar la herramienta Cuadro de
seccion. Para habilitarlo, simplemente marque la opcién Casilla de seccion en la ventana Propiedades de
la vista.
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A continuacidn, aparecera una casilla de verificacion, que puede ajustar para recortar solo el entorno

deseado.

Revit MEP
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Properties X
@ 3D View b
3D View: Isometric Plumbing ~ Edit Type
Scale Value 1: 100 ~
Detail Level Medium
Parts Visibility Show Qriginal
Visibility/Graphics Overr... Edit...
Graphic Display Options Edit...
Discipline Plumbing
Show Hidden Lines By Discipline
Default Analysis Display...None
Sub-Discipline Plumbing
Sun Path ]
Extents %
Crop View ]
Crop Region Visible ]
Annotation Crop ]
Far Clip Active ]
Far Clip Offset 304.8000 m
Scope Box Mone
Section Box
Camera 8
Rendering Settings Edit... ™

Properties help
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D
Nota: Si la casilla de verificacién no esta visible, debe hacer clicen * Revelar elementos ocultos en la
barra de vista previa y luego aparecera.

Usando las flechas en la casilla de verificacidn, debe arrastrarlas o hacer clic en la direccién en la que desea
mover el limite de la casilla hasta llegar a un resultado similar al de la imagen a continuacion.

&

Para ocultar la casilla de verificacién, debe hacer clic con el botén secundario en ella, hacer clic en Ocultar
en la vista y seleccionar elementos.
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Cancel

Repeat [Hide Elements]
Recent Commands

Hide in View

Override Graphics in View
Create Similar

Edit Family

Select Previous

Select All Instances
Delete

Reset Crop Boundary to Model
Reset Crop Boundary to Screen
Find Referring Views

Zoom In Region

Zoom Out (2x)
Zoom To Fit

Previous Pan/Zoom
Next Pan/Zoom
Browsers

~  Properties

v
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Elements.
Category
By Filter...

hr4

Lo mismo se puede hacer para el equipo sanitario (lavabo, inodoro, ducha) si desea que solo aparezcan
tuberias y conexiones en la vista isométrica, como en la imagen a continuacién.

5.6.6. Crear hojas

La creacion de hojas para imprimir se realiza exactamente a través del mismo procedimiento descrito en
el tutorial del modelo de arquitectura (consulte el punto 5.11 del tutorial de Revit Architecture). En este
caso, siguiendo las mismas instrucciones, debe crear una o mas hojas que contengan las dos vistas de
planta y las dos vistas isométricas que se crearon en este tutorial.
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